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Abstract 

Characterization of the 3D nanostructure of Calcium Silicate Hydrates by using 
Transmission Electron Microscope (TEM) 

by 

Panod Viseshchitra 

Doctor of Philosophy in Earth and Planetary Science 

University of California, Berkeley 

Professor Hans-Rudolf Wenk,  Chair 

 

Calcium silicate hydrate (C-S-H) is the main hydration product of Portland cement 
that mainly contributes to concrete's physical and mechanical properties. The 
porosity of C-S-H plays a vital role in the durability-based performance of concrete. 
Most of the information about the microstructure of C-S-H now is only in 2D due to 
the complex morphologies of hydration products.  

This dissertation aims to investigate synthetic C-S-H and C-A-S-H with various Ca/Si 
ratios and curing temperatures using  Transmission Electron Microscope (TEM) 
tomography.  The 3D reconstructions of all samples were done using the 
simultaneous iterative reconstruction technique (SIRT). The highest beam dose 
that doesn’t damage the samples for TEM tomography is 5000 e-/(nm2 s) for all 
samples. The 3D reconstructions and selected ROI analysis confirm that there are 
only foil-like structures for all C-S-H and C-A-S-H samples. Both CPSD and CMIP 
reveal that most of the pore sizes of all samples are below 40 nm. However, C-S-H 
at Ca/Si ratio 1.0 and 1.6 seem to have pore sizes larger than 100 nm. The curing 
temperature causes a lower porosity in the structure of both C-S-H and C-A-S-H. 
However, the porosity is not affected by chemical composition. 

Scanning transmission electron microscopy (STEM) is used to compare the results 
with TEM. The 3D results of both TEM and STEM tomography show no significant 
difference. Still, the continuous pore size distribution with CMIP simulations shows 
a remarkable difference. C-S-H at Ca/Si ratio 1.0 from TEM tomography has 3 
dominant pore sizes at 22.2, 28.8 and 37.7 nm, while STEM tomography has only 
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one dominant pore size at 6.0 nm. The pore network’s size of TEM_C-S-H 1.0 is 
significantly larger but less dense than STEM_C-S-H 1.0. 

A preliminary study of a fluid flow model has been accomplished. Both porosity and 
permeability increase with samples higher Ca/Si ratio, and higher equilibrated 
temperatures. The successful model will enhance the understanding of the 
relationship of mechanical properties and porosity of cement and concrete. 

TEM tomography combine with Xlib plugin in ImageJ shows the capability to 
determine the 3D nanostructure and pore networks of C-S-H and C-A-S-H. To 
determine the sustainability of cements and concrete, the understanding of the 
relationship of mechanical properties and porosity is needed. The resulting 
information of 3D nanostructure and pore analysis provide these critical 
information for developing a new generation of optimized green cement and 
concrete. 
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1. Introduction 
 

Portland cement was first discovered by Joseph Aspin in 1824 (Bogue, 1947; 
Hewlett & Liska, 2019). Portland cement-based concrete has been used as the 
primary construction material for the modern infrastructure for over one hundred 
years (Monteiro et al., 2017). The reasons behind its success are attributed to its 
robust, excellent resistance to water, leading to a controllable and high-
performance behavior, and to the low cost and global availability of the raw 
materials used in Portland cement manufacture and concrete production (Mehta 
& Monteiro, 2014). According to the U.S. Geological Survey, the yearly production 
of Portland cement has increased dramatically in the past century, with annual 
manufacture of 4.1 billion metric tons in 2018 (U.S. Geological Survey, 2018), 
adding 2.9 billion metric tons of CO2 into the atmosphere and contributing 
significantly to global warming. Green concrete contains alternative compounds to 
reduce the carbon footprint during the manufacturing process (Imbabi et al., 2012; 
Phair, 2006). It uses less energy in its production and may contain industrial by-
products such as fly ash or blast furnace slag, reducing the generation of CO2.  The 
change in existing technologies to produce efficient green concrete requires 
optimization of the micro/nano structure such that less cement will be needed in 
its manufacture. Some essential hydration products such as calcium silicate hydrate 
(C-S-H) consist of particles generally a few nanometers in size (McDonald et al., 
2010; Scrivener & Nonat, 2011), which significantly contribute to the concrete 
mechanical behavior (Königsberger et al., 2018; Scrivener et al., 2004). Several 
imaging techniques have been used to characterize the pore network, such as 
transmission electron microscopy (TEM) (Taylor et al., 2015), Focused Ion Beam/ 
Scanning Electron Microscopy (FIB/SEM) (Holzer, Gasser, and Müench 2006; 
Münch and Holzer 2008), and X-ray imaging (Bae, Taylor, Shapiro, et al., 2015; 
Bossa et al., 2015; Li et al., 2019). 

The reactive Portland cement powder, mainly consisting of tricalcium silicate 
(Ca3SiO5, or C3S in the cement notation which C for CaO, S for SiO2) and dicalcium 
silicate (Ca2SiO4, or C2S), can be mixed with water to produce a hardened material 
through complex reactions that produce the main binding product: calcium silicate 
hydrate (C-S-H). 

C-S-H formed during the hydration process is the main binding phase and primary 
contributor to the mechanical properties of most hydrated Portland cement and 
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concretes. The C-S-H phases have poorly ordered crystal structures resembling the 
mineral tobermorite (Ca5Si6O16(OH)2·7H2O) (Bonaccorsi et al., 2005; H. F. W. Taylor, 
1997). The poor crystallinity and short-range order character of C-S-H have 
prevented a satisfactory structural description with conventional X-ray diffraction 
techniques (H. F. W. Taylor, 1992). To better understand the C-S-H structure, a 
precise 3-dimensional model of C-S-H at the nanoscale is needed. 

 

The porosity of C-S-H plays a crucial role in the durability-based performance of 
concrete. The size distribution and connectivity of the pores determine the ability 
of fluids and ions to flow through the network, potentially degrading the material. 
The nanostructure of C-S-H determines both the porosity and the pore size 
distribution. To date, there have been several studies on the nanostructure and 
morphology of a variety of Portland-cement-based systems (Bae, Taylor, 
Hernández-Cruz, et al. 2015; Bae, Taylor, Shapiro, et al. 2015; Korpa, Kowald, and 
Trettin 2009; Richardson 2000; Taylor, Richardson, and Brydson 2010). While such 
studies answer many questions, such as phase development in the system, the 
results of these techniques, including scanning electron microscopy, are distilled 
into two-dimensional (2D) information that provides only limited, often inferred, 
volumetric information of the nanostructure, and the pore network for a bulk 
paste. Simulations can also be used for these investigations (e.g. Garboczi & Bentz, 
1992; Navi & Pignat, 1999). Due to the complex nature of cement hydration and 
the sensitivity of the products formed, only a few studies of the three-dimensional 
(3D) structure at the nanoscale have been completed (Song et al., 2019).  

Transmission electron microscopy (TEM) can image specimens at very high 
resolution. It is widely used in materials science, including observations of cement, 
for example, to observe the morphology of hydration products of cements 
(Richardson, 1999, 2008; Richardson & Groves, 1992; Richardson, Skibsted, Black, 
& Kirkpatrick, 2010; Taylor et al., 2010). to characterize the effect of mineral 
admixtures, such as fly ash, slag, and metakaolin (Trusilewicz et al., 2012), on the 
hydration reactions (Bullard et al., 2011).  

Electron tomography uses TEM images to reconstruct the 3D structure of an object 
from a series of projection images from different viewing angles. This method has 
been applied to many porous systems in materials science, such as in the imaging 
of nanoscale dendrites (Saghi et al., 2008). A recent study (Taylor et al., 2015) used 
electron tomography to investigate the nanostructure and pore network of C-S-H 
and found two separate networks of pores that are most likely attributed to two 
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particles of the same phase in different orientations. Due to the sensitivity of C-S-
H to the electron beam, beam damage still occurred, and improvements are 
needed to develop a robust protocol for TEM tomographic studies of cementitious 
materials.  To acquire tomographic tilt series, the sample is rotated, and a series of 
2D projection images is measured at different tilt angles (Ercius et al., 2015). This 
research studied synthetic C-S-H instead of hydrated C3S because of the desire to 
have only one phase in the system. The 3D reconstruction method used in this 
experiment is the simultaneous iterative reconstruction technique (SIRT) method 
(Miao et al., 2016).  

Scanning transmission electron microscopy (STEM) is another mode of TEM. STEM 

satisfies the incoherent imaging approximation in which diffraction and phase 

contrast is decreased, and the image intensity depends on the sample thickness 

and the atomic number (LeBeau et al., 2008). Also, the digital control of the beam 

in STEMs can minimize radiation damage (Marks, 1999). With STEM, we can reach 

higher magnification and less beam damage compared to conventional TEM (Scott 

et al., 2012).  

Combining of electron tomography and model analysis giving detail of pore size 
distribution and permeability. This study investigates and compares the 3D 
structure of C-S-H and C-A-S-H with various Ca/Si ratios at the nanoscale using 3D 
electron tomography. The resulting information of pore analysis is critical for the 
development of a new generation of optimized green cement. 
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2. Literature review 
 

2.1 Portland cement and Concrete 
 

Cement is a material that becomes rigid and develops compressive strength, 
properties known as setting and hardening when hydration reactions with water 
take place. It is produced by heating a mixture of limestone (CaCO3) and SiO2 with 
traces of Al2O3 and Fe2O3 up to 1450°C. In the heating process, CaCO3 decarbonates 
to form CaO, and then, four phases are formed at higher temperatures undergoing 
clinkering reactions. The typical elemental composition of the finished product, 
clinker, is about 65% CaO (C), 25% SiO2 (S), 5% Al2O3 (A), 3% Fe2O3 (F) and 2% of 
other components. Some gypsum (calcium sulfate) is added to the clinker, in order 
to slower the hydration reaction, and the mixture is ground to form cement. 
Cement contains 4 main hydraulic phases: C3S or alite (Ca3SiO5), C2S or belite 
(Ca2SiO4), C3A or tricalcium aluminate (Ca3Al2O6) and C4AF or calcium aluminoferrite 
(Ca2(Al, Fe)O5) (Taylor 1997). 

Tricalcium silicate (C3S or alite) is stable within the temperature range of 1250-1800 
ºC. The high-temperature forms can be stabilized at room temperature by adding 
ions from the raw materials used in cement manufacture, and it is this impure C3S 
which is known as alite. Alite is normally monoclinic. The most common ions that 
alite contains in clinkers are Mg2+, Al3+, Fe3+, K+, Na+, and SO3. 

Dicalcium silicate (C2S or belite) is found in clinkers is typically βC2S, which is 
stabilized at room temperature with substituent ions. The ions found in solid 
solution are mainly Al3+, Fe3+, Mg2+, K+, SO4

2- and PO4
3-. The presence of alkalis, such 

as K+, stabilizes βC2S with respect to γC2S after the clinkering process during cooling. 

Tricalcium aluminate (C3A) is cubic when pure. It reacts vigorously with water, but 
the strength of the product is low. It can also contain substituent ions such as Fe3+, 
Mg2+, Na+, K+ , and Si4+. 

Calcium aluminoferrite (C4AF) is the only phase of the particular compositions of 
ferrite that is found in clinkers. Some foreign ions can also be found in this phase, 
the most common being Mg2+, Si4+, and Ti4+. Increasing the A/F ratio enhances the 
reactivity of calcium aluminoferrite with water, which is moderate in general. 
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The reaction of tricalcium silicate with water gives two hydration products 
(Equation 2.1). 

2C3S + 7H → C3S2H4 + 3CH Equation 2.1 

The products are an almost amorphous calcium silicate hydrate phase and 
portlandite (calcium hydroxide, CH) (Taylor, 1997). This phase has the form of 
hexagonal crystals and has been found to be present as finely dispersed 
microcrystals in cement pastes of low water to solid ratio (Groves, 1981), or large 
imperfect crystals in C3S pastes (Groves et al., 1986). The calcium silicate hydrate 
phase is named C-S-H, where the hyphens imply that its chemical composition can 
vary.  

In hydration, the quantity of silicate species changes in C-S-H. The isolated silicate 
tetrahedra in C3S are transformed to disilicate ions, and a higher degree of 
polymerization appears over time. Polymerization occurs in chains rather than 
sheets or 3D networks. After six months, the dimer content reaches a maximum of 
around 60% and decreases to about 50% after one year. Meanwhile, the content 
of polymeric species rises to 50% from the first year to 30 years of hydration 
(Mohan & Taylor, 1982).  

The reaction of dicalcium silicate with water also gives C-S-H and CH (Equation 2.2). 

2C2S + 5H → C3S2H4 + CH  Equation 2.2 

The proportion of produced CH is about a fifth of the amount produced in the 
hydration of tricalcium silicate. The rate of hydration of C2S is much lower than for 
tricalcium silicate. The rate of hydration does not affect the C-S-H composition, 
which is the same composition that results from hydrating C3S (Taylor 1997). 
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2.2 Calcium Silicate Hydrate (C-S-H) 
 

There are several minerals such as gyrolite, xonotlite, clinotobermorite, 
tobermorite 9Å, tobermorite 11Å, tobermorite 14 Å and jennite that have similar 
structure like calcium silicate hydrates. The comparison of XRD patterns of C-S-H 
formed in cement pastes with those of the natural minerals tobermorite, and 
jennite has shown that C-S-H has some structural features related to them 
(Bonaccorsi, Merlino, and Taylor 2004; Elena Bonaccorsi, Merlino, and Kampf 
2005). Synthetic imperfect forms of tobermorite and jennite formed in aqueous 
suspensions, called C-S-H (I) and C-S-H (II) are also related to C-S-H (Taylor 1997). 
Thomas et al. (2010) have shown that C-S-H has a much higher atomic packing 
density than both tobermorite and jennite. This may be due to its defective atomic 
structure and to nano solid effects linked to its nanoparticulate morphology. The 
example of a TEM image of C-S-H at Ca/Si ratio 1.6 is shown in Figure 2.1. 

 

Figure 2.1 TEM image of C-S-H at Ca/Si ratio 1.6 
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Richardson and Groves (1992, 1993) proposed a general model that could be 
interpreted from the tobermorite/jennite or tobermorite/calcium hydroxide 
perspective. This model did not fix the level of protonation of the silicate chain. The 
generalized model is very similar to many previous models for the structure of C-S-
H, but its generality allows for the specific inconsistencies of other models to be 
compensated.  

The widely proposed molecular structure of C-S-H, at curing temperature below 80 
°C, is similar to tobermorite 14Å (Bullard et al., 2011). The current model of C-S-H 
consists of complex layers of central octahedral calcium oxide sheets with 
tetrahedral silicate chains on both sides, which are attached with a periodicity of 
three tetrahedra (Figure 2.2). The space between two complex layers contains 
additional calcium cations and H2O.  

 

 

Figure 2.2 Schematic of the atomic structure of C-S-H. The layers of octahedral 
calcium oxide sheet (CaO6) are drawn in dark grey, whereas the light grey triangles 
are SiO4

4- tetrahedra. The interlayer contains water and positively-charged species 
(blue circles and green squares, respectively) that can neutralize the structure (e.g. 
Ca2+ and/or K+) (Bonaccorsi et al., 2005) 
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2.3 Calcium Alumino Silicate Hydrate (C-A-S-H) 
 

C-A-S-H is another key binding phase and a primary contributor to the mechanical 
properties of most hydrated cement and concretes. Increasing amounts of Al-
containing cementitious precursors, mainly industrial wastes, e.g. fly ash, ground 
granulated blast furnace slag (GGBFS), and calcined clay, are being used in modern 
cements. These cements form C-A-S-H with higher Al content on hydration. The 
example of C-A-S-H at Ca/Si ratio 1.0 Al/Si ratio 0.05 is shown in Figure 2.3.  

 

 

Figure 2.3 TEM image of C-A-S-H at Ca/Si ratio 1.0, Al/Si ratio 0.05 

 

The atomic structure of non-cross-linked C-A-S-H is similar to non-cross-linked C-S-
H, but the aluminate tetrahedron is incorporated in the silicate chain of C-S-H at 
bridging sites. The substitution of tetrahedral silicate by tetrahedral aluminate 
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gives more negative charged basal layer, which requires more cations to charge-
balance the entire structure compared to C-S-H (Abdolhosseini et al., 2012). The 
atomic structure of C-A-S-H at a curing temperature of 80 °C or higher is similar to 
Al-tobermorite 11Å (Merlino et al., 2001). Double chains of tetrahedral 
aluminosilicate in cross-linked C-A-S-H are formed by cross-linking of two bridging 
sites (Yang et al., 2018). The atomic structure of C-A-S-H is shown in Figure 2.4. 

 

 

Figure 2.4 Schematic of the atomic structure of non-cross-linked C-A-S-H (left) and cross-linked C-A-S-H 

(right). The layers of octahedral calcium oxide sheet are drawn in dark grey, whereas the light grey 

triangles are SiO4
4- tetrahedra. The red triangles represent aluminate tetrahedra at bridging sites and 

cross-linking sites. The interlayer contains water and positively-charged species (blue circles and green 

squares, respectively) that can neutralize the structure (e.g., Ca2+ and/or K+) 

 

The solid phase for both of C-S-H at Ca/Si ratio 1.0 and C-A-S-H at Ca/Si ratio 1.0, 
Al/Si ratio 0.05 was analyzed by X-ray diffractometry (XRD) and only 3 peaks of         
C-S-H is observed at around 8°, 34°, and 37° 2θ . There is no portlandite nor 
evidence of carbonation. The XRD results are shown in Figure 2.5. 



10 
 

 

Figure 2.5 XRD results of C-S-H at Ca/Si ratio 1.0 (green line) and C-A-S-H at Ca/Si 
ratio 1.0, Al/Si ratio 0.05 (blue line). Three main peaks of both C-S-H and C-A-S-H 
are at around 8°, 34°, and 37° 2θ. 
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3. Transmission Electron Microscope (TEM) 
tomography 

 

3.1 Introduction 
 

The TEM is based on the transmission of an electron beam through a very thin 
sample (thickness less than 100 nm). The field emission gun generates a beam of 
electrons accelerated to high voltage (the TEM working voltage). The electron 
beam is first focused by the two condenser lenses on the sample, which largely 
determines the spot size of the experiment. The beam is limited by the condenser 
aperture, knocking out high-angle electrons. The beam strikes the sample, and 
parts of it are transmitted. This transmitted beam is focused by the objective lens 
into an image. Optional Objective and Selected Area apertures can restrict the 
beam; the Objective aperture is enhancing contrast by blocking out high-angle 
diffracted electrons, the Selected Area aperture enabling the user to examine the 
periodic diffraction of electrons by ordered arrangements of atoms in the sample. 
The image is passed through the column through the intermediate and projector 
lenses, being enlarged all the way. The image hits the phosphor screen, and light is 
generated, allowing the user to see the image. (Reimer & Kohl, 2008; Williams & 
Carter, 2009).  

Three types of images can be taken in TEM, which are bright field, dark field, and 
high-resolution images. In the bright field mode, an aperture is inserted in the back 
focal plane of the objective lens to block the diffracted beams. This results in a 
contrast image where the areas of the sample that diffract more appear dark while 
the areas of the sample where the electron beam is more transmitted straight 
through appear bright. TEM bright field images have been widely used in cement 
and concrete research. For taking images of cementitious samples, it is important 
not to go to much higher magnification because serious beam damage can be 
induced in the sample. The higher magnification means the smaller area but the 
same intensity. Hydrated cement has low melting temperatures and low thermal 
conductivity, leading to thermal damage (Richardson, 2002).  
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Figure 3.1 Schematic diagram of TEM (Williams & Carter, 2009). 
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3.2 Tomography 
 

The term tomography has been used to describe the process of imaging by sections 
(Penczek, 2010). The tomography was done in 5 steps, including sample 
preparation, data acquisition, data alignment, data reconstruction, and object 
visualization. 
The sample can be prepared the same way as a conventional TEM sample. For data 
acquisition, the sample is tilted to the highest degree until the view is blocked by 
the instrument. The number of images can be different while ensuring the tilting 
range is at the full possible range to record more images. The angle increment is 
normally set as 2°, 1° or 0.5°. Images in a tilt series were manually aligned to a 
common coordinate system then shifted and rotated to center the axis of rotation. 
To align the data, we have to choose one fixed point (FP) (Brandt, 2006; Liu et al., 
1995). This fixpoint should be easy to see and have high contrast in all images. Gold 
fiducial markers are usually added to the system to generate the dominant FP. Then 
we have to align the FP to be in the same position in both X and Y directions.  
Data reconstruction is a mathematical process that is straightforward using existing 
computing programs. There are many different algorithms for reconstructing a 3D 
object from a tilt series, such as simple back projection (BP) (Berry et al., 1970; 
Bracewell & Riddle, 1967), weighted-back projection (WBP) (P. F. Gilbert & Aaron, 
1972), algebraic reconstruction technique (ART) (Gordon et al., 1970), 
simultaneous iterative reconstruction technique (SIRT) (P. Gilbert, 1972). In 
electron tomography, tilt ranges are limited to 130 degrees. This results in a missing 
wedge of information, obviously as artifacts in a reconstruction (Arslan et al., 2005; 
Midgley & Weyland, 2003). The missing wedge in a weighted back-projection 
reconstruction can be directly visualized by reducing the threshold intensity value 
displayed in the color map and then viewing the object down the experimental tilt 
axis. Although several techniques, including proper sample preparation, data 
acquisition, and denoising methods, can decrease the experimental errors and 
reduce noise, iterative tomographic reconstruction algorithms are more suitable 
than noniterative methods. The in-depth detail of some reconstruction methods is 
provided in the next part.  
Visualization of the reconstructed volume is done either by volume rendering or by 
surface rendering. The volume rendering was optimized by adjusting the color and 
the transparency of the different parts. For the surface rendering, an initial 
segmentation was obtained by thresholding the data(Kübel et al., 2005). The 
alignment, reconstruction, and visualization were done using the tomviz software 
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(Levin et al., 2018). Tomviz is an open-source software for volumetric visualization 
and data processing, especially for electron tomography. The tomviz platform 
based on Python allows graphical analysis of 3D datasets. 

3.3 The reconstruction methods 
 

3.3.1 Weighted-Back projection 
 

The basic method is Simple Back Projection, which projects 2D images back into 3D, 
and compares the projections acquired at different angles to try to recover the 
structure of the 3D object. In this study, a weighted-back projection algorithm, 
which builds on these more basic algorithms to produce high-quality 
reconstructions, is used. The relation between the three-dimensional Fourier 
transform and the mass density distribution (Reimer & Kohl, 2008) of the specimen 
is written as: 

F(qx, qy, qz) = ∭ ρ(x, y, z) exp[−2πi(qxx + qyy + qzz)] dxdydz   Equation 3.1 

 

Where ρ(x, y, z) is the specimen density distribution from a series of projections. 
However, a micrograph with the electrons incident parallel to z corresponds to a 
central section through the Fourier space in the qx, qy plane, so the transform 
reduces to: 

F(qx, qy, 0) = ∭ ρ(x, y, z) exp[−2πi(qxx + qyy)] dxdy    Equation 3.2 

 

We will get F(qx, qy, qz) from a tilt series, which is equivalent to a bundle of central 
sections through the Fourier space, so ρ(x, y, z) can be calculated by an inverse 
Fourier transform. 

In electron tomography, tilt ranges are limited to about 140 degrees due to 
shadowing of the specimen holder and space limitations in the TEM specimen 
chamber. This results in a missing wedge of information, which produces artifacts 
in a reconstruction (Arslan et al., 2005; Midgley & Weyland, 2003). The missing 
wedge in a weighted back-projection reconstruction can be directly visualized by 
reducing the threshold intensity value displayed in the color map and then viewing 
the object down the experimental tilt axis. Although several techniques, including 
well sample preparation, data acquisition, and denoising methods, can decrease 
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the experimental errors and reduce noise, iterative tomographic reconstruction 
algorithms are more suitable than noniterative methods.  

 

 

3.3.2 Simultaneous iterative reconstruction technique (SIRT) 
 

The concept of SIRT is to iterative reconstruct a system of linear equations to 
reduce artifacts. In other words, we repeat doing WBP until we get a better result. 
We start with the linear system 

Ax = b   (1)     Equation 3.3 
where x represents the image, b represents the projections, and matrix A 
represents the image process (forward projection). The transposed matrix, AT, 
back-projects the projections onto the reconstruction area. SIRT takes forward and 
back projections repeatedly. The update equation is 
 

xt+1 =  x(t) + GATR (b − Ax(t))          Equation 3.4 
 

Where G and R are diagonal matrices that contain the inverse of the sum of the 
columns and rows of the system matrix. Iterations start with x(0)=0. The updated 
equation then does the following things. The current reconstruction at x(t) is 
forward projected, Ax(t). The result is subtracted from the originals: b − Ax(t). The 
difference is the back-projected, which is done by multiplying with AT, but weighted 

with G and R. This results in the correction factor GATR (b − Ax(t)). The corrective 
factor is added to the current reconstruction, and the whole process is repeated. 
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3.4 Experimental Methods 
 

3.4.1 Materials 

C-S-H and C-A-S-H was synthesized by mixing calcium oxide (CaO), silica fume (SiO2), 

and monocalcium aluminate (CaO⋅Al2O3) at different Ca/Si and Al/Si molar ratios 
with water. CaO was obtained by burning calcium carbonate (CaCO3, Merck, pro 
analysis) at 1000 °C for 12 hours. SiO2, provided by Aerosil 200, Evonik, was chosen 
for its high specific surface area. The synthesis process and all the sample handling 
were carried out in an N2 filled glovebox to prevent CO2 contamination. The 
samples were stored in 100 mL high-density polyethylene (HDPE) containers placed 
on a shaker moving at 100 rpm and equilibrated at various temperatures. For each 
equilibration time, a separate sample was prepared. After equilibrated for 182 
days, the solid and the liquid phase were separated by filtration using a 0.45 μm 
nylon filter. Each sample detail is shown in Table 3.1. 

Table 3.1 Detail of Ca/Si ratio, Al/Si ratio, and equilibrated temperature for each 
sample. 

Ca/Si 
ratio 

Al/Si 
ratio 

Equilibrated 
Temperature 

(°C) 

Angle 
Start (°) 

Angle 
End (°) 

Angle 
increment (°) 

0.6 0.00 20 -60 60 1 

0.8 0.00 20 -70 70 2 

1.0 0.00 20 -45 70 1 

1.2 0.00 20 -65 65 1 

1.4 0.00 20 -60 60 2 

1.6 0.00 20 -60 60 1 

1.0 0.00 7 -70 70 2 

1.0 0.00 50 -65 65 1 

1.0 0.00 80 -70 70 1 

1.0 0.05 7 -65 65 2 

1.0 0.05 50 -65 65 2 

1.0 0.05 80 -65 65 1 



17 
 

3.4.2 Electron Tomography 

 
The electron tomography requires several steps, including sample preparation, 
data acquisition, data alignment, data reconstruction, and object visualization, as 
described in section 3.2. The sample was suspended in ethanol and deposited on a 
200 mesh ultra-thin copper hexagonal grid with carbon film support (CF200H-Cu-
UL, Electron Microscopy Sciences). 10 nm gold fiducial markers (Aldrich) were 
deposited to aid in tilt series alignment. Data acquisition was acquired on a Tecnai 
12 TEM (Figure 3.2), operating at 120 kV. All images were acquired automatically 
using the SerialEM software. The angle start, angle end, and angle increment are 
shown in Table 3.1. The number of images for each sample is equal to the total 
images(angle start plus angle end) divided by the angle increment. 
 

 

Figure 3.2 TEM Tecnai 12 at Electron Microscope Lab (EML), UC Berkeley 
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The alignment, reconstruction were done by using the IMOD software (Kremer et 
al., 1996). More detail on the alignment and reconstruction are in section 7.1 and 
7.2. Visualization of the reconstructed volume was done either by volume or 
surface rendering. The volume rendering was optimized by manually adjusting the 
color and the transparency. The visualizations were done using the Tomviz 1.8 
software (Levin et al., 2018) and napari (Sofroniew et al., 2021). IMOD, Tomviz, and 
napari are open source software for volumetric data processing and visualization, 
especially for electron tomography.  The example of a TEM image of C-S-H with 
Ca/Si ratio 1.0 is shown in Figure 3.3. 
 

 

Figure 3.3 2D image of C-S-H with Ca/Si ratio 1.0. The black dots in blue circles are 
gold fiducial markers. 
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3.4.3 Model analysis 
 

The pore analysis of the reconstructed models was obtained by using the 
Fiji/ImageJ software. The segmentation, which allows isolating pores to C-S-H, is 
based on global thresholding with the Otsu algorithm (Otsu, 1979). The porosity is 
calculated based on the ratio of the white area (particles) divided by the total area. 
The continuous pore size distribution (CPSD) and continuous pore size distribution 
with mercury intrusion porosimetry simulation (CMIP) were determined by using 
the Xlib plugin (Münch & Holzer, 2008) in ImageJ. For CPSD, the pore space is 
separated into regions of different radii that can be filled with objects of different 
radii (Münch & Holzer, 2008). The sizes of these radii are attached to the respective 
locations. For CMIP, same PSD definition as for the CPSD. However, the balls of 
different radii are intruded into the pore volume from one of the faces of the 3D 
image cube or from one of the edges of the 2D image, respectively. This definition 
of the PSD corresponds to the data collected by mercury intrusion porosimetry 
(MIP) (Münch & Holzer, 2008). 
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3.5 Results and Discussion 
 

3.5.1 Beam damage on TEM tomography 
 

Beam damage is a major problem in electron tomography due to the longer time 
to complete the whole series of images. Our particles were sensitive to beam 
irradiation, so we were careful to limit the dose and to check for damage before 3D 
reconstruction.  

 

The electron dose  (e-/(nm2 s))  =  
M

D⋅A⋅E
  Equation 3.5 

 

Where M is the average number of counts per pixel (counts / pixel).  

D is the number of counts per electron (counts per electron).  

A is the area per pixel (nm2 / pixel). 

E is the acquisition time per image (second). 

A beam dose of 5000 e-/(nm2 s) is suitable for this research and applies to all 
conventional TEM tomography for both C-S-H and C-A-S-H. The example of the 
effect of beam damage is shown in Figure 3.4. As seen in equation 3.5, the 
magnification is directly proportional to M, so the higher magnification means the 
greater beam damage. 
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Figure 3.4 Compare the 2D images of C-S-H 1.6 at 0° rotation (A) before and (B) 
after tomography at 23 kX magnification. (C) before and (D) after tomography at 
18 kX magnification. 
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3.5.2 Effects of Ca/Si ratio on the structure of C-S-H 
 

The 2D images and 3D reconstructed models are shown in Figure 3.5 to Figure 3.10. 
The distinguished black dots that may appear in several models are gold fiducial 
markers. 

 

Figure 3.5 2D image and 3D reconstruction of C-S-H 0.6: (A) 2D image, (B) 3D at 0° 
rotation, (C) 3D at 45° rotation, (D) 3D at 90° rotation. The 3D image is a 2D section 
through the 3D model. 
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Figure 3.6 2D image and 3D reconstruction of C-S-H 0.8: (A) 2D image, (B) 3D at 0° 
rotation, (C) 3D at 45° rotation, (D) 3D at 90° rotation. The 3D image is a 2D 
section through the 3D model. 

 



24 
 

 

Figure 3.7 2D image and 3D reconstruction of C-S-H 1.0: (A) 2D image, (B) 3D at 0° 
rotation, (C) 3D at 45° rotation, (D) 3D at 90° rotation. The 3D image is a 2D 
section through the 3D model. 
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Figure 3.8 2D image and 3D reconstruction of C-S-H 1.2: (A) 2D image, (B) 3D at 0° 
rotation, (C) 3D at 45° rotation, (D) 3D at 90° rotation. The 3D image is a 2D 
section through the 3D model. 
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Figure 3.9 2D image and 3D reconstruction of C-S-H 1.4: (A) 2D image, (B) 3D at 0° 
rotation, (C) 3D at 45° rotation, (D) 3D at 90° rotation. The 3D image is a 2D 
section through the 3D model. 
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Figure 3.10 2D image and 3D reconstruction of C-S-H 1.6: (A) 2D image, (B) 3D at 
0° rotation, (C) 3D at 45° rotation, (D) 3D at 90° rotation. The 3D image is a 2D 
section through the 3D model. 
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The 2D images are collected in Brightfield TEM mode. We can see that the C-S-H 

morphology of all Ca/Si ratios in the system is a combination of foil-like structures 

and elongated (fiber-like) structures. However, these particles have a complex 3D 

morphology, and simple 2D TEM projection images are insufficient to describe the 

morphology.  

The morphologies of C-S-H are determined by the structure and chemical 

composition and/or kinetically of the hydration reaction (Richardson, 2004). The 

morphologies of both C-S-H are made up of elongated, connected structures with 

different orientations.   

Next, we will take a closer look at the elongated regions of interest (ROIs) to 

investigate the underlying morphology at higher resolution. Elongated ROIs refer 

to foil-like structures that are perceived as fibers when observing the original 2D 

projection images of such structures. Two samples, C-S-H 1.0 and C-S-H 1.6, were 

selected to determine the real morphology. The visualization of two models were 

done by software Tomviz (Levin et al., 2018). Five ROIs were selected for each 

sample (Figure 3.11). The particles sit randomly on a TEM grid. The original 

projection direction with the grid approximately flat is arbitrary set as 0-degree 

rotation. Then we rotate 90° around the parent fiber direction. Each ROI is shown 

in 0° rotation and 90° rotation (Figure 3.12 for C-S-H 1.0 and Figure 3.13 for C-S-H 

1.6). The actual geometry and aspect ratios of these ROIs are shown in Table 3.2. 

The thickness (a) of each ROI can be determined from the orientation looking along 

with the plate. The width (b) and length (c) can be determined from the direction 

normal to the plate. The thickness (a), width (b), and length (c) are represented by 

red lines in both Figure 3.12 and Figure 3.13. Both 2D aspect ratios have high values 

(more than 5), indicating that all of them are elongated platelets, not fibers. 
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Figure 3.11 The 3D models C-S-H 1.0 (A) and 1.6 (B) visualized by software Tomviz.  

Five selected elongated ROIs are indicated by red rectangles. 

 

Table 3.2 Actual geometry and aspect ratio of selected ROIs of both samples.  

Sample           

C-S-H 1.0 
Thickness 
(a) (nm) 

Width 
(b) (nm) 

Length 
(c) (nm) 

2D Aspect 
ratio (b/a) 

2D Aspect 
ratio (c/a) 

Particle 1 7.15 73.00 149.00 10 21 
Particle 2 7.76 84.89 171.52 11 22 

Particle 3 6.06 76.89 106.24 13 18 
Particle 4 6.32 68.11 78.97 11 12 

Particle 5 5.46 62.10 99.37 11 18 

C-S-H 1.6 
Thickness 
(a) (nm) 

Width 
(b) (nm) 

Length 
(c) (nm) 

2D Aspect 
ratio (b/a) 

2D Aspect 
ratio (c/a) 

Particle 1 8.13 58.85 141.06 7 17 

Particle 2 4.27 56.05 83.16 13 19 
Particle 3 10.19 49.82 156.05 5 15 
Particle 4 4.94 42.50 94.80 9 19 

Particle 5 3.83 37.63 76.40 10 20 
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Figure 3.12 Morphologies of five selected elongated ROIs of C-S-H 1.0 

 

 



31 
 

 

Figure 3.13 Morphologies of five selected elongated ROIs of C-S-H 1.6 
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Figure 3.14 Pore size distributions of C-S-H at Ca/Si ratio 0.6, 0.8, 1.0, 1.2, 1.4 and 
1.6 at curing temperature 20° C (A) Continuous pore size distribution (CPSD), (B) 
Cumulative continuous pore size distribution (CCPSD), (C) Continuous pore size 
distribution with MIP simulation (CMIP), (D) Cumulative continuous pore size 
distribution with MIP simulation (CCMIP) 

 

Continuous pore size distribution (CPSD) and Continuous pore size distribution with 

MIP simulation (CMIP) was analyzed in this research (Figure 3.14). The voxel sizes 

and porosities are shown in Table 3.3. Both CPSD and CMIP reveal that most of the 

pore sizes of all samples are below 40 nm. However, C-S-H 1.0 and C-S-H 1.6 seem 

to have larger pore sizes than the rest. For CPSD, both C-S-H 1.0 and C-S-H 1.6 have 

a larger pore size up to 100 nm (Figure 3.14A). For CMIP, C-S-H 1.0 and C-S-H 1.6 

have a dominant peak at 28.8 nm. 
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Table 3.3 Voxel size, porosity, pore size range for C-S-H with various ratios 

Sample 
Voxel size 

(nm) 
Porosity 

(%) 
CPSD pore size 

range (nm) 
CMIP pore size 

range (nm) 

C-S-H0.6_AS0_20C 0.91 36.7 2 - 27 2 - 23 
C-S-H0.8_AS0_20C 1.12 20.2 2 - 29 2 - 22 
C-S-H1.0_AS0_20C 1.11 66.8 2 - 104 2 - 66 
C-S-H1.2_AS0_20C 1.62 16.5 3 - 42 3 - 29 
C-S-H1.4_AS0_20C 0.69 14.7 1 - 19 1 - 19 
C-S-H1.6_AS0_20C 1.14 49.8 2 - 109 2 - 93 
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3.5.3 Effect of curing temperature on the structure of C-S-H and C-A-S-H 
 

 The 2D images and 3D reconstructed models are shown in Figure 3.15 to Figure 

3.20.  

 

Figure 3.15 2D image and 3D reconstruction of C-S-H 1.0 at curing temperature 7° 
C : (A) 2D image, (B) 3D at 0° rotation, (C) 3D at 45° rotation, (D) 3D at 90° 
rotation. The 3D image is a 2D section through the 3D model. 
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Figure 3.16 2D image and 3D reconstruction of C-S-H 1.0 at curing temperature 50° 
C : (A) 2D image, (B) 3D at 0° rotation, (C) 3D at 45° rotation, (D) 3D at 90° rotation. 
The 3D image is a 2D section through the 3D model. 
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Figure 3.17 2D image and 3D reconstruction of C-S-H 1.0 at curing temperature 80° 
C : (A) 2D image, (B) 3D at 0° rotation, (C) 3D at 45° rotation, (D) 3D at 90° rotation. 
The 3D image is a 2D section through the 3D model. 
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Figure 3.18 2D image and 3D reconstruction of C-A-S-H 1.0 with Al/Si 0.05 at curing 
temperature 7° C : (A) 2D image, (B) 3D at 0° rotation, (C) 3D at 45° rotation, (D) 3D 
at 90° rotation. The 3D image is a 2D section through the 3D model. 
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Figure 3.19 2D image and 3D reconstruction of C-A-S-H 1.0 with Al/Si 0.05 at curing 
temperature 50° C : (A) 2D image, (B) 3D at 0° rotation, (C) 3D at 45° rotation, (D) 
3D at 90° rotation. The 3D image is a 2D section through the 3D model. 
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Figure 3.20 2D image and 3D reconstruction of C-A-S-H 1.0 with Al/Si 0.05 at curing 
temperature 80° C : (A) 2D image, (B) 3D at 0° rotation, (C) 3D at 45° rotation, (D) 
3D at 90° rotation. The 3D image is a 2D section through the 3D model. 
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The morphology of all C-S-H and C-A-S-H at various curing temperatures are only 

foil-like structures. The elongated morphology is still platelets, not fibers. 

Continuous pore size distribution (CPSD) and Continuous pore size distribution with 

MIP simulation (CMIP) were also analyzed in this research (Figure 3.21). The voxel 

sizes and porosities are shown in Table 3.4. Both CPSD and CMIP, all C-S-H samples 

have a pore size range below 40 nm, while C-A-S-H samples have a higher pore size 

range around 31 and 69 nm. For CMIP, C-A-S-H1.0_AS0.05_50C has a dominant 

peak at 19.4 nm (Figure 3.21C).  

For the porosity, results strongly indicated that the higher the curing temperature, 

the lower porosity occurred.  

 

 

Table 3.4 Voxel size, porosity, the pore size range for C-S-H with various ratios 

Sample 
Voxel size 

(nm) 
Porosity 

(%) 

CPSD pore 
size range 

(nm) 

CMIP pore 
size range 

(nm) 

C-S-H1.0_AS0_7C 0.91 47.7 2 - 38 2 - 23 
C-S-H1.0_AS0_50C 1.14 24.8 2 - 27 2 - 25 
C-S-H1.0_AS0_80C 1.14 21.1 2 - 41 2 - 25 

C-A-S-H1.0_AS0.05_7C 1.62 51.7 3 - 68 3 - 55 
C-A-S-H1.0_AS0.05_50C 1.14 24.6 2 - 31 2 - 23 
C-A-S-H1.0_AS0.05_80C 1.92 20.2 4 - 69 4 - 50 
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Figure 3.21 Pore size distributions of C-S-H 1.0 at curing temperature 7, 50, 80° C 
and C-A-S-H 1.0, A/S 0.05: at curing temperature 7, 50, 80° C (A) Continuous pore 
size distribution (CPSD), (B) Cumulative continuous pore size distribution (CCPSD), 
(C) Continuous pore size distribution with MIP simulation (CMIP), (D) Cumulative 
continuous pore size distribution with MIP simulation (CCMIP) 
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3.6 Conclusions 
 

This chapter uses TEM tomography with simultaneous iterative reconstruction 
technique (SIRT) to generate the 3D reconstruction of C-S-H and C-A-S-H 
microstructures which can be found in Portland cement paste or C3S paste. The 
projection images were aligned using the 10 nm gold nanoparticles as references. 
The highest beam dose that can achieve this with a little beam damage is 5000 e-

/(nm2 s) for all samples.  

The 3D reconstructions and selected ROI analysis confirm that there are only foil-
like structures for all C-S-H and C-A-S-H with various Ca/Si, Al/Si, and curing 
temperatures.  

Both CPSD and CMIP reveal that most of the pore sizes of all samples are below 40 
nm. However, C-S-H1.0_AS0_20C, C-S-H1.6_AS0_20C, C-A-S-H1.0_AS0.05_7C, and          
C-A-S-H1.0_AS0.05_80C seem to have larger pore size than the rest. The porosity 
is affected by the curing temperature. The higher curing temperature will make the 
lower porosity in the structure of both C-S-H and C-A-S-H. 

There are many advanced reconstruction methods like The algebraic 
reconstruction technique (ART) (Herman et al., 1973), the equal slope tomography 
(EST) (Jiang et al., 2010; Lee et al., 2008) that can solve the missing wedge and other 
artifact problem better than the simultaneous iterative reconstruction technique 
(SIRT). However, these methods required longer analysis time, complex 
methodology, and high-performance computers. 

TEM tomography combined with the Beat plugin in ImageJ shows the capability to 
determine the 3D nanostructure and pore networks of C-S-H and C-A-S-H. 
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4.  Scanning Transmission Electron Microscope 
(STEM) tomography 

 

4.1 Introduction 

 

Figure 4.1 Schematic of the instrument configuration for STEM (Williams & Carter, 
2009) 
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Scanning transmission electron microscopy (STEM) (Williams & Carter, 2009) 
combines the principles of transmission electron microscopy (TEM) and 
scanning electron microscopy (SEM). STEM requires very thin samples like 
TEM and focuses at electrons transmitted by the sample. A schematic of 
STEM is shown in Figure 4.1. 
 
 
One of the TEM problems is the interference of the diffracted beam when it 
interacts with the crystalline solids at the atomic scale. A minor change in 
crystal structure or orientation can produce radically different intensities and 
patterns in the recorded image (Frank, 2008). This limits the application of 
electron tomography using TEM (Koster et al., 2000). This issue can be solved 
by using STEM. The pre-specimen optics create a convergent electron probe 
at the sample surface focused on a small diameter. The convergent beam 
electron diffraction (CBED) pattern is produced after the specimen, and a 
single-channel detector is used to combine the electron flux within a range 
of scattering angles. STEM provides a wide range of operating modes from 
nanometer to sub-angstrom resolution, depending on the electron source, 
accelerating voltage, convergence angle, and lens settings. The most 
common detector in STEM is a high-angle annular dark-field (HAADF) 
detector designed to collect only highly scattered electrons (more than 50 
mrad) (Pennycook, 1989). HAADF-STEM can differentiate materials with 
different atomic numbers (Z -contrast imaging), but it has a high sensitivity 
for high-Z elements (Ercius et al., 2006). However, this characteristic is not 
an advantage to our materials because cements mainly consist of Calcium 
and Silicon, which are low-Z elements. 
 
A significant advance in STEM with direct application to electron tomography 
has been the wide-scale introduction of aberration correctors. The focusing 
power of the electron lenses used in STEM is limited by spherical aberration, 
where the minimum probe size is defined as: 

 

𝑑𝑚𝑖𝑛 =  0.433/4𝐶3
1/4

 Equation 4.1 
 
Where C3 is the third-order spherical aberration (also called Cs ), and λ is the 
wavelength of the incident electrons (Scherzer, 1936). Spherical aberration 
causes electrons from the center of the lens to be focused to a different point 



45 
 

along the optical axis and increases the size of the focused electron beam at 
the sample. STEM is typically limited to electron probes with >1 Å resolution, 
making many important features at the atomic scale unresolvable. The round 
electron lenses always create positive spherical aberration coefficients, but 
it was shown that other optical with non-round symmetry could be 
combined to generate negative spherical aberration (Scherzer, 1947). 
Ideally, the C3 value of round objective lenses can be compensated by 
introducing electron-optical elements to the column, but this has been 
proved extremely difficult for many years (Uhlemann & Haider, 1998). 
 
Further developments in lens power supply, electron-optical theory, and 
other concerted efforts in the field have recently led to the realization of 
aberration correction through the use of multipole elements capable of 
compensating for the aberrations of an optical system (Krivanek et al., 2001).  
With this technology, almost all aspects of electron microscopy 
instrumentation have been improved. The resolution is reduced to 0.5–1 Å, 
the contrast is greatly improved, and the beam current is increased. These 
improvements now allow microscopists to measure atomic distances for 
most crystalline materials, even individual atoms, and make atomic-
resolution spectroscopic measurements (Huang et al., 2012; Krivanek et al., 
2013). 

 

4.2 Experimental Methods 
 

4.2.1 Materials 

C-S-H 1.0 at curing temperature 20° C was used in this experiment. For sample 
details, see section 3.4.1. The angle range is modified to -70° to +69.5° with a 1.5-
degree angle increment. 

 

4.2.2 Electron tomography 
The sample was suspended in ethanol and deposited on a 200 mesh ultra-thin 

copper hexagonal grid with carbon film support (CF200H-Cu-UL, Electron 

Microscopy Sciences). 10 nm gold fiducial markers (Aldrich) were deposited to aid 

in tilt series alignment. Data acquisition was acquired on a FEI TitanX 60-300 
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microscope (Figure 4.2), operating at 300 kV. Images are acquired with a Gatan 

HAADF detector for STEM. The reconstruction method and model analysis are 

similar to those described in sections 3.4.2 and 3.4.3. 

 

Figure 4.2 TEM Titan X at The National Center for Electron Microscopy (NCEM), 
LBNL 

 

4.2.3 Pore connectivity 
 

The number of connected structures in a network can be determined by calculating 

the Euler characteristic. The Euler characteristic of a 3D structure is the number of 

particles plus the number of enclosed cavities minus the connectivity (Odgaard & 

Gundersen, 1993). The connectivity density can be calculated by dividing the 

connectivity estimate by the volume of the specimen. The algorithm in BoneJ's 

Connectivity uses voxel to calculate the Euler characteristic of the volume and 

adjusts this to give the contribution of the volume to the connectivity of the 

structure it was cut from. The analysis can be done in BoneJ (Doube et al., 2010), 
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which is a plugin in ImageJ. The connectivity density can be calculated from the 

equation below. 

 

C.D. = 
1 − Δχ

stack volume
   Equation 4.2 

 

Where C.D. is the connectivity density, Δχ is the difference of Euler characteristic 

between the intersections of voxels and stack edges. 
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4.3 Results 
 

In this section, two results are compared. The TEM tomography of C-S-H 1.0 at 
curing temperature 20° C (Figure 3.7) and STEM tomography of C-S-H 1.0 at curing 
temperature 20° C (STEM_C-S-H 1.0) is shown in Figure 4.3. 

 

 

Figure 4.3 2D STEM image and 3D STEM reconstruction of C-S-H 1.0: (A) 2D image, 
(B) 3D at 0° rotation, (C) 3D at 45° rotation, (D) 3D at 90° rotation. The 3D image is 
a 2D section through the 3D model. 
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Figure 4.4 Pore size distributions of TEM_C-S-H 1.0 and STEM_C-S-H 1.0: (A) 
Continuous pore size distribution (CPSD), (B) Cumulative continuous pore size 
distribution (CCPSD), (C) Continuous pore size distribution with MIP simulation 
(CMIP), (D) Cumulative continuous pore size distribution with MIP simulation 
(CCMIP) 

 

Table 4.1 Voxel size, porosity, pore size range, and connectivity density for C-S-H 
from TEM and STEM tomography 

Sample 
Voxel 
size 
(nm) 

Porosity 
(%) 

CPSD pore 
size range 

(nm) 

CMIP pore 
size range 

(nm) 

connectivity 
density (cm-3)  

TEM_C-S-H 
1.0 

1.11 66.8 2 - 104 2 - 66 3.21E-03 

STEM_C-S-H 
1.0 

1.40 63.9 2 - 80 2 - 38 7.60E-03 
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The morphologies of TEM_C-S-H 1.0 are similar to STEM_C-S-H 1.0. They are both 
made up of elongated, connected structures with different orientations. Also, there 
is no fiber-like structure in both samples. The voxel size, porosity, pore size range, 
and connectivity density of TEM_C-S-H 1.0 and STEM_C-S-H 1.0 are shown in Table 
4.1. 

 

The pore analysis shows that TEM_C-S-H 1.0 and STEM_C-S-H 1.0 have porosities 
of 66.8% and 63.9%, respectively. Continuous pore size distribution (CPSD) and 
Continuous pore size distribution with MIP simulation (CMIP) was analyzed in this 
research (Figure 4.4). CPSD (Figure 4.4A) reveals that TEM_C-S-H 1.0 has a pore size 
range between 2 – 110 nm, and STEM_C-S-H 1.0 has a pore size range between 2 – 
75 nm. However, CMIP shows different results from CPSD. TEM_C-S-H 1.0 has three 
dominant peaks at 22.2, 28.8, and 37.7 nm, while STEM_C-S-H 1.0 has only one 
dominant peak at 6.0 nm. (Figure 4.4C). The connectivity density of TEM_C-S-H 1.0 
is 3.21 x 10-3 cm-3 while STEM_C-S-H 1.0 is 7.60 x 10-3 cm-3. 

 

4.4 Discussion 
 

There is no large difference in terms of morphologies for both 2D images or 3D 
models. Both TEM and STEM provide good quality images that can generate good 
3D reconstructed models. The pore analysis in ImageJ suggests that TEM_C-S-H 1.0 
has a little bit higher porosity than STEM_C-S-H 1.0 (66.8% and 63.9%, 
respectively).  The cumulative pore size distribution for both CPSD and CMIP (Figure 
4.4B, 4.4D) also indicates that TEM_C-S-H 1.0 has a higher porosity than STEM_C-
S-H 1.0. The peak pore size for TEM_C-S-H 1.0 (Figure 4.4A, 4.4C) ranges from 2 to 
110 nm, while for STEM_C-S-H 1.0, it ranges from 2 to 75 nm. There are also peaks 
with pore size larger than 100 nm for TEM_C-S-H 1.0 (Figure 4.4A, 4.4C) which 
means, the pore network’s size of TEM_C-S-H 1.0 is significantly larger than of 
STEM_C-S-H 1.0. The connectivity density of STEM_C-S-H 1.0 is much higher than 
TEM_C-S-H 1.0. This result indicates that the pore network of STEM is denser than 
TEM. However, these results are not indicated that the two methods always give 
different results since they are the same sample. 
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From the results, there is no conclusion which methods is better. Both TEM and 
STEM have advantages and disadvantages for use in electron tomography for 
cementitious materials. TEM is more efficient compared to STEM due to the low 
probability of high-angle scattering required for STEM, especially for low-Z 
materials. Low-dose imaging is a strength of TEM, which is suitable for soft 
materials. STEM has the advantage that intensities of images are directly 
interpretable due to incoherent scattering. 

Another advantage of STEM is that no Bragg diffracted electrons are collected due 
to the inner angle of the HAADF detector is made so larger than 50 mrad. The 
images, therefore, come from elastically scattered electrons that have passed very 
close to the atomic nuclei in the sample. STEM with HADDF works well with 
crystalline materials, but C-S-H are nanocrystalline materials, the image quality 
from STEM is not much different from conventional TEM. 

Another point to consider is the stability of samples and beam damage. Since the 
STEM uses a focused beam of electrons to scan over a specimen, the exposure time 
to the electron beam is much longer. The samples may be moved or destroyed by 
the high-energy beam of the electron. 

 

4.5 Conclusions 
 

This chapter compared the result of C-S-H 1.0 at curing temperature 20° C from 
TEM and STEM tomography. The porosity from ImageJ shows that both TEM_C-S-
H 1.0 and STEM_C-S-H 1.0 are not much different. However, the continuous pore 
size distribution with MIP simulation (CMIP) is different. The pore network’s size of 
TEM_C-S-H 1.0 is significantly larger but less dense than STEM_C-S-H 1.0. Both TEM 
and STEM show the capability to determine the 3D nanostructure of cementitious 
materials.  
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5.  A model of fluid flow in C-S-H and C-A-S-H 
 

 

5.1 Introduction 
 

Porosity plays an important role in cement and concrete system. It can affect the 
mechanical properties of concrete such as the compressive strength-modulus of 
elasticity relationship (e.g. Popvics, 1973). Also, porosity has an important role in 
the frost resistance of concrete (Zhou et al., 2006; Zuber & Marchand, 2000). The 
ability of ions to migrate through cementitious materials influences the extent of 
several degradation mechanisms such as sulphate attack, carbonation, leaching, 
chloride transport in marine structures and contaminant transport in hazardous 
waste disposal systems (Patel et al., 2014, 2018). Therefore, improving the 
understanding of the transport mechanisms through cementitious materials is very 
important for predicting the long-term performance and service life of concrete 
structures. 

The mathematical modeling of the flow in a porous system can be based on 
Darcy’s law: 

𝑞 =  −
𝑘

𝜇
 ∇𝑝  Equation 5.1 

q is the flux or discharge per unit area (m/s), k is the permeability (m2),  is the 
dynamic viscosity of the fluid (Pa.s), ∇𝑝 is the pressure drop (Pa). 

The permeability of the 3D image is computed using Darcy’s law by applying 
pressure gradient in the direction of interest. For this study, we apply pressure 
gradient in the x-direction. With these given boundary conditions fluid flow 
equation described later is solved to obtain a steady-state fluid velocity field inside 
the porous media. Using this steady-state velocity field, permeability can be 
computed as  

𝜅𝑥 =
〈𝑢𝑥〉𝜇

d𝑃/d𝑋
  Equation 5.2 

Where, 〈𝑢𝑥〉 is the average fluid velocity in the x-direction in the computational 
domain at steady state, 𝜅  is permeability, and d𝑃/d𝑋  is the applied pressure 
gradient in the x-direction. The pressure gradient is applied using a forcing scheme. 
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The average velocity in x-direction used for permeability computation is then 
computed from the velocity field as  

〈𝑢〉 =
1

𝑉
 ∫ 𝑢 𝑑𝑣

𝑉
≈

1

𝑁
∑ 𝑢𝑥𝑁𝑓

 Equation 5.3 

Where 𝑁𝑓 are the number of fluid voxels, and 𝑁 is the total number of voxels in the 

image. 

To obtain the velocity to compute permeability, one needs to solve  continuity and 
Navier-Stokes (NS) equations in the pore geometry  

∇. u = 0     Equation 5.4 

ρ
𝜕u

𝜕𝑡
+ ρu. ∇u = −∇P + μ∇2u + F Equation 5.5 

where ρ is density, u is velocity, P is pressure, μ is dynamic viscosity, and F is body 
force.  

The above equation is solved in this work using two relaxation time lattice 
Boltzmann method (Talon et al., 2012) implemented in open source code yantra 
(Patel, 2016). In LBM, instead of discretizing NS equations directly it solves the 
discretized version of the lattice Boltzmann equation (discretized in velocity space 
and physical space), which describes the behavior of probability distribution 
function of the particles (𝑓). It can be shown that this discretized lattice Boltzmann 
equation can recover the NS equations using multiscale Chapman-Enskog 
expansion.    

The two-relaxation time lattice Boltzmann method scheme provides additional 
tuning parameter which can be used to remove error terms related to no-slip 
boundary conditions on solid walls.  In two relaxation time, the symmetric (fi

+)and 
anti-symmetric (fi

−) components of the distribution function defined below using 
separate relaxation parameters.  

fi
+ =

fi+f−i

2
 &  fi

− =
fi−f−i

2
  Equation 5.6 

Where Ci =  −𝐶𝑖 . ci  is the discrete velocity of lattice defined later. The 
corresponding governing lattice Boltzmann equations   is given as below [] 

fi(x + ciΔt, t + Δt) = fi(x, t) + Ωi
+(f) + Ωi

−(f) + Fi
LBΔt   Equation 5.7 

Where 
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Ωi(f)+/−    =
−Δt

τ+/−
(fi

+/−
− fi

eq+/−
)      Equation 5.8   

fi
eq

= wiρ (1 +
u.ci

cs
2 +

(u.ci)2

2cs
4 −

u.u

2cs
2)    Equation 5.9 

Fi
LB = Δt wi (1 −

Δ𝑡

2𝜏+
) 𝐹𝛼

𝑇𝑅𝑇+ + Δt wi (1 −
Δ𝑡

2𝜏−
) 𝐹𝛼

𝑇𝑅𝑇− Equation 5.10 

Fα
TRT = (

ci−uα

cs
2 +

ciuα

cs
4 ci) Fα     Equation 5.11 

cs
2 =

1

3
. (

Δx

Δt
)2       Equation 5.12 

In the above equations, Δx and Δt are space and time resolutions. fi  is discrete 

velocity distribution function, fi
eq

 is equilibrium distribution function and τ+ and  

τ−  are relaxation time for symmetric and anti-symmetric components of the 
distribution function. Discrete velocities ci and their corresponding set of weighing 
coefficients wi will form velocity sets. 

 

5.2 Experimental Methods 
 

The data used in this section are selected from the models from Chapter 3. Sample 
details are shown in Table 5.1. The cropped 3D model of C-S-H 1.0 at curing 
temperature 7° C is shown in Figure 5.1. The porosity is determined by ImageJ, 
referred to section 3.4.3. 

The simulation of fluid flow is based on Darcy’s law and the lattice Boltzmann 
method. The flux and dynamic viscosity are fixed. Then a constant gradient 
pressure is applied to all cropped models only in the X-direction. After the 
simulation, the permeability is generated.  
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Figure 5.1 Cropped model of C-S-H 1.0 at 7° C from TEM tomography 

 

5.3 Results and Discussion 
 

Table 5.1 Details of 3D tomography models, porosity, and permeability for all 
samples. 

Data Original 3D model 
Porosity 

(%) 
Permeability 

(m2) 

Crop1 C-S-H 1.0 at 7° C 50.1 6.31E-19 
Crop2 C-S-H 1.0 at 20° C 59.8 4.23E-18 
Crop3 C-S-H 1.0 at 50° C 76.2 6.58E-18 
Crop4 C-S-H 1.4 at 20° C 83.3 6.99E-18 
Crop5 C-A-S-H 1.0, A/S 0.05 at 50° C 55.4 1.55E-18 
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Figure 5.2 Graph shows relationship between porosity (%) and permeability (m2) of 
5 cropped samples 

 

From Table 5.1, the porosity of all data ranges from 50.1 to 83.3%. The permeability 
ranges from 6.31x10-19 to 6.99x10-18 m2. Figure 5.2 shows the graph between 
porosity and permeability show a very good linear relationship (R2 = 0.922). This 
indicates the promising results for a good model of fluid flow. 

The pores sizes range of cement pastes varies from nanometre spaces within the 
C-S-H to micron-sized capillary pores. This difference has a huge impact on the 
permeability of the system (Patel et al., 2018). The former research (Banthia & 
Mindess, 1989; Nyame & Illston, 1981; Song et al., 2019; Vichit-Vadakan & Scherer, 
2003; Wong et al., 2009; Ye, 2005; Zalzale et al., 2013) on permeability values 
reported in the literature vary widely from 10−22 to 10−16 m2 for cement pastes with 
various water-to-cement (w/c) ratios. Although the experimental conditions of this 
literature and our models are not identical, the results on permeability, which are 
range from 6.31x10-19 to 6.99x10-18 m2, show a promising result on model fitting.  

From the results, there are several characteristics between chemical composition, 
equilibrated temperatures, porosity, and permeability. Both porosity and 
permeability increase with samples with a higher Ca/Si ratio and higher 
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equilibrated temperatures. The stability of C-S-H depends on the permeability. If 
the water quickly flows through the structure, the deterioration, including 
corrosion of steel reinforcement, and freeze-thaw attack, occurred at a faster rate 
too (Dolado & van Breugel, 2011). These results indicate that the stability of C-S-H 
depends on the chemical compositions and equilibrated temperatures.    

 

5.4 Conclusions 
 

This chapter has presented a preliminary study of the flow model. The data show 
that the stability of C-S-H depends on the chemical compositions and equilibrated 
temperatures. The results show a good relationship between porosity and 
permeability and provide new insight into a fluid flow model of cementitious 
materials. However, more data need to be calculated to generate robust models. 
The successful model will enhance the understanding of the relationship of 
mechanical properties and porosity of cement and concrete.  
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6.  Conclusions and further work 
 

In this dissertation, electron tomography was applied to study synthetic C-S-H and 
C-A-S-H with various Ca/Si ratios and curing temperatures. The experimental 
studies include: 

- Beam damage on TEM tomography 
- Effects of Ca/Si ratio on the microstructure of C-S-H 
- Effect of curing temperature on the structure of C-S-H and C-A-S-H 
- Comparison between TEM and STEM tomography 
- A model of fluid flow in C-S-H and C-A-S-H 

The resulting information of pore analysis is critical for the development of a new 
generation of optimized green cement. The important conclusions from each 
chapter are listed below. 

 

1. TEM tomography with simultaneous iterative reconstruction technique 
(SIRT) can generate the 3D reconstruction of C-S-H and C-A-S-H 
microstructures which can be found in Portland cement paste or C3S paste. 
The highest beam dose that can achieve this without significant beam 
damage is 5000 e-/(nm2 s) for all samples. The 3D reconstructions and 
selected ROI analysis confirm that there are only foil-like structures for all C-
S-H and C-A-S-H samples. Both CPSD and CMIP reveal that most of the pore 
sizes of all samples are below 40 nm. However, C-S-H1.0_AS0_20C, C-S-
H1.6_AS0_20C, C-A-S-H1.0_AS0.05_7C, and C-A-S-H1.0_AS0.05_80C seem 
to have larger pore size than the rest. The higher curing temperature will 
make the lower porosity in the structure of both C-S-H and C-A-S-H. TEM 
tomography combine with the Beat plugin in ImageJ shows the capability to 
determine the 3D nanostructure and pore networks of C-S-H and C-A-S-H. 
 

2. Both TEM and STEM tomography show the capability to determine the 3D 
nanostructure of cementitious materials. The 3D results of both TEM and 
STEM tomography show no distinguished difference, but the continuous 
pore size distribution with MIP simulation (CMIP) shows an outstanding 
difference. The pore network’s size of TEM_C-S-H 1.0 is significantly larger 
but less dense than STEM_C-S-H 1.0. 
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3. A fluid flow model's preliminary results show a good relationship between 
porosity and permeability and provide new insight into a model of fluid flow 
of cementitious materials. Both porosity and permeability increase with 
samples with a higher Ca/Si ratio and higher equilibrated temperatures. The 
stability of C-S-H depends on the chemical compositions and equilibrated 
temperatures. 

 

Based on the results of this dissertation, a few suggestions for future investigations 
of cementitious materials, designing high performance and green concrete can be 
addressed here: 

- Studies of real hydration products like C3S or cement paste to compare the 
results with idealized systems. 

- Some advanced reconstruction methods like the algebraic reconstruction 
technique (ART), the equal slope tomography (EST) that can solve the missing 
wedge and other artifact problem better than the simultaneous iterative 
reconstruction technique (SIRT). However, these methods required longer 
analysis time, complex methodology, and high-performance computers. 

- To generate models of fluid flow, more data are needed to confirm the 
results. 
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7. Appendix 
 

7.1 Create a 3D model with Tomviz 
 

Tomviz is an open source application for the processing, visualization, and analysis 
of 3D tomographic data. It can render and analyze voluminous 3D tomograms. The 
platform provides a graphical interface where objects can be rendered as shaded 
contours or volumetric projections. Tomographic reconstructions of experimental 
data are possible within Tomviz. This manual refers to the Tomviz version 1.8.0. 
First, the reconstruction is a lengthy work. To avoid any errors, saving state often 
by going to the File tab and clicking “Save State”. This saves a .tvsm file. To continue 
or recover your work, .tvsm files can be loaded into tomviz by going to File and 
clicking “Load State”. 

1. Loading data set 
 
Go to File > Open Data  
Normal data sets are usually in .tiff or .mrc files. 
   

2. Define tilt serie 
 
Go to tomography> Mark Data as Tilt Series 
Set number of images that want to use and the overall angle of the 
experiment. 
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Figure 7.1 Set tilt angles in Tomviz 

3. Image alignment 
 
Go to tomography> Image Alignment (Manual) 

Image Alignment (Manual) allows the user to align the data by manually 
shifting the images so that the position of fiducial markers are the same in 
every image. Manual alignment to very small fiducial particles is a very 
accurate and commonly used alignment method. 

There are two display modes. “Toggle Images” flashes between two images 
that are being aligned at a frame rate specified by the user. “Show 
Difference” maps the difference in value between two images being aligned, 
plotted on a color scale specified by the user (Blue to Red shown below), 

Images can be aligned to the previous image in the tilt series, the next image 
in the series, or to a fixed reference image in the series. Use the keyboard’s 
arrow keys to shift the images until the fiducial particles line up, or enter 
shifts manually into the shift array in the lower right of the dialog box.  
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Figure 7.2 Manual image alignment in Tomviz 

4. Tilt axis alignment 
 
Go to tomography> Tilt Axis Alignment (Manual) 
 
This brings up another dialog box. Here, you choose 3 slices (shown by the 
red lines), and the software computes a quick reconstruction showing you 
what each of those slices through the 3D volume will look like with your 
current tilt axis alignment. You should put one of your slices on a fiducial 
particle, and place the other two on interesting features of the sample if 
possible. 
Adjust the angle and position of the tilt axis (yellow line) to minimize 
artifacts. For example, the fiducial nanoparticles should be spherical but may 
appear crescent-shaped if the tilt axis is in the wrong position. 
The color map for each reconstructed slice can be changed separately to 
aid users in searching for artifacts. Once satisfied that the tilt axis is correct, 
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click “Transform Data to Axis of Rotation”. Wait for the software to 
transform the data, and then proceed to reconstruction. 
 

 

Figure 7.3 Manual tilt axis alignment in Tomviz 

 
5. 3D reconstruction 

 
Go to tomography> Weighted Back Projection or Simultaneous Iterative 
Recon. Technique(SIRT) 
 
This step may take several hours to complete depend on tge reconstruct 
condition. 
 
 

6. Visualizing 3D Data 
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Click the volume icon (the purple square at the far right) to see the 3D 
volume data.  
Sometime, it may be good to see the contour by click the green contour 
icon (Second to the left). 
 

 

Figure 7.4 Visualizing icons 

 
7. Save model 

 
Go to File > Save Data 

 The model can be saved either in .emd or .tiff files. 
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7.2 Create a 3D model with Etomo 
 

Another method that can generate 3D model is Etomo. Etomo is a software based 

on linux system. Using Etomo on Windows is possible but not recommended due 

to many bugs and uncompatible issues. 

 

In this manual, we refer to Etomo version 4.11. 

1. Opening program 

Open the terminal (Ctrl + Alt + T) then type etomo. Click Built Tomogram. 

 

 

2. Loading data set (Figure 7.5) 

 

- The files that can be opened are .st files. If your file is in .tiff or .mrc, you 

can just change it to .st file.  

- Select “Single axis” 

- Click “Scan Header” 

- Fill the the fiducial diameter size. 

- Click “Create Com Scripts” 

 

3. Coarse Alignment (Figure 7.6) 

 

- Click “Calculate Cross-Correlation”  

- Click “Generate Coarse Aligned Stack”  

- Click “Done” 
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Figure 7.5 Setup tomogram in Etomo 

 

 

Figure 7.6 Coarse Alignment in Etomo 
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4. Fiducial model 

 

- Click “Fiducial Model Gen.”. 

- Fill the total number of fiducial markers in total number 

- Click “Generate Seed Model”. 

- Click tab “Track Beads”.  

- Click “Track Seed Model” then click “Fix Fiducial Model” (Figure 7.8).  

- Use the Page Up key (when an up arrow is above the point) or the Page 

Down key (when a down arrow is above the point) to find the section with 

the missing point and use the middle mouse button to add the point in 

the center of the fiducial markers (Figure 7.9). 

 

 

Figure 7.7 Fiducial Model Generate in Etomo 
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Figure 7.8 Fiducial Model Generate in Etomo (2) 

 

 

Figure 7.9 Fix Fiducial Model in Etomo 
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5. Fine Alignment 

 

- Set all parameters as Figure 7.10 and Figure 7.11 then click “Compute 

Alignment”. 

- Click “Done”. 

  

 

 

Figure 7.10 Fine Alignment in Etomo 
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Figure 7.11 Set Global Variables in Etomo 
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6. Tomogram Positioning 

 

- Set thickness to 2000 

- Click “Create Sample Tomograms”. 

- Click “Create Boundary Model”. 

- Click “Compute Z Shift & Pitch Angles”. 

- Click “Create Final Alignment”. 

- Click “Done”. 

 

 

Figure 7.12 Tomogram Positioning in Etomo 
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7. Final Aligned Stack 

 

- Set binning to “2”. 

- Click “Create Full Aligned Stack”. 

- Click “Done”. 

 

 

 

Figure 7.13 Final Aligned Stack in Etomo 
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8. Tomogram Generation 

 

- Click “Back Projection” or “SIRT” 

- If SIRT is selected, fill the number of iteration (can be filled more than 

one number). 

- Click “Generate Tomogram”. 

- Wait for several hours, depend on the number of iteration. 

- The reconstructed model will be saved in .srecxx ,where xx is the 

number of iteration. 

- To open the file in Tomviz, just change .srecxx to .rec. 

 

 

 

 

Figure 7.14 Tomogram Generation in Etomo 
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7.3 Visualization with napari  
 

Napari is the software that help visualization 3D model. It also . This software can 

be downloaded from https://github.com/napari/napari. It can be installed as 

standalone software or python code. 

 

1. First, click File > Open. Then select the data. Click the cube icon at the 

bottom to convert stack of 2D images to 3D model (Figure 7.15). 

 

 

Figure 7.15 Software napari 

 

https://github.com/napari/napari
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2. Next, set the rendering package on the left console to “minip” to better see 

the model (Figure 7.16). Sometime, the default package (mip) 

 

 

Figure 7.16 Set rendering package 
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3. Manually adjusting the contrast limits and gamma is required since the 

image characters will be appeared/disappeared based on these parameters. 

The example of model is shown in Figure 7.17. 

 

 

 

 

Figure 7.17 The 3D model of C-A-S-H at Ca/Si 1.0, Al/Si 0.05 at equilibrated 
temperature 7° C, before adjusting the contrast limits and gamma (A), After 
adjusting (B) 
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7.4 Particle and Pore Analysis with ImageJ  
 

The main software in this session is Fiji (Fiji is an imageJ with plugins). Another 
important plugin that needed to be installed is Xlib (Münch & Holzer, 2008) which 
can downloaded from ftp://ftp.empa.ch/pub/empa/outgoing/BeatsRamsch/lib/ . 
After finish download, install from ImageJ Updater (Plugins > Install… > xlib_.jar). 
The new plugins can be found under Plugins > Beat. 

 

1. Threshold data set  
- Go to Image > Adjust > Threshold. Then select the method that is 

appropriated (Figure 8.15). 
- Click “Convert to Mask”. 
- Check only “Calculate threshold for each image” then Click “OK”. 
- The result should be in black and white only (like Figure 8.16). 
 

 

Figure 7.18 Threshold adjusting of C-S-H 1.0. 

 

ftp://ftp.empa.ch/pub/empa/outgoing/BeatsRamsch/lib/
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Figure 7.19 Threshold image of C-S-H 1.0. 

 
 

2. Pore Size Distribution (Figure 7.20) 
- Go to Plugins > Beat > Pore Size Distribution 
- Choose “Continuous PSD” or “Discrete PSD”. 
- Check “Entire Stack Processing?” then select “3D PSD”. 
- Check “Write results to output files?” then select the location. 
- Click “OK”. 
- Wait for several minutes. 
- The result file is saved in the selected location. 
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Figure 7.20 Pore Size Distribution in ImageJ 

 
 
 

 

 

 

  



80 
 

8. References 
 

Abdolhosseini, Q., Mohammad, J., Ulm, F.-J., and Pellenq, R. J.-M. (2012). Evidence on the dual 
nature of aluminum in the calcium-silicate-hydrates based on atomistic simulations. 
Journal of the American Ceramic Society, 95(3), 1128–1137. 

Arslan, I., Yates, T. J. V., Browning, N. D., and Midgley, P. A. (2005). Embedded nanostructures 
revealed in three dimensions. Science, 309(5744), 2195 LP – 2198. 

Bae, S., Taylor, R., Hernández-Cruz, D., Yoon, S., Kilcoyne, D., and Monteiro, P. J. M. (2015). Soft 
x-ray spectromicroscopic investigation of synthetic C-S-H and C3S hydration products. 
Journal of the American Ceramic Society, 98(9), 2914–2920. 

Bae, S., Taylor, R., Shapiro, D., Denes, P., Joseph, J., Celestre, R., Marchesini, S., Padmore, H., 
Tyliszczak, T., Warwick, T., Kilcoyne, D., Levitz, P., Monteiro, P. J. M., and Struble, L. (2015). 
Soft X‐ray ptychographic imaging and morphological quantification of calcium silicate 
hydrates (C–S–H). Journal of the American Ceramic Society, 98(12), 4090–4095. 

Banthia, N., and Mindess, S. (1989). Water permeability of cement paste. Cement and Concrete 
Research, 19(5), 727–736. 

Berry, M. V., Gibbs, D. F., and Burch, C. R. (1970). The interpretation of optical projections. 
Proceedings of the Royal Society of London. A. Mathematical and Physical Sciences, 
314(1517), 143–152. 

Bogue, R. H. (1947). Chemistry of portland cement. Reinhold. 

Bonaccorsi, E., Merlino, S., and Kampf, A. R. (2005). The crystal structure of tobermorite 14 Å 
(plombierite), a C–S–H phase. Journal of the American Ceramic Society, 88(3), 505–512. 

Bonaccorsi, E., Merlino, S., and Taylor, H. F. W. (2004). The crystal structure of jennite, 
Ca9Si6O18(OH)6·8H2O. Cement and Concrete Research, 34(9), 1481–1488. 

Bossa, N., Chaurand, P., Vicente, J., Borschneck, D., Levard, C., Aguerre-Chariol, O., and Rose, J. 
(2015). Micro- and nano-X-ray computed-tomography: a step forward in the 
characterization of the pore network of a leached cement paste. Cement and Concrete 
Research, 67, 138–147. 

Bracewell, R. N., and Riddle, A. C. (1967). Inversion of fan-beam scans in radio astronomy. The 
Astrophysical Journal, 427–434. 

Brandt, S. S. (2006). Markerless Alignment in Electron Tomography. In J. Frank (Ed.), Electron 
Tomography: Methods for Three-Dimensional Visualization of Structures in the Cell (pp. 
187–215). Springer New York. 

Bullard, J. W., Jennings, H. M., Livingston, R. A., Nonat, A., Scherer, G. W., Schweitzer, J. S., 
Scrivener, K. L., and Thomas, J. J. (2011). Mechanisms of cement hydration. Cement and 
Concrete Research, 41(12), 1208–1223. 



81 
 

Dolado, J. S., and van Breugel, K. (2011). Recent advances in modeling for cementitious 
materials. Cement and Concrete Research, 41(7), 711–726. 

Doube, M., Kłosowski, M. M., Arganda-Carreras, I., Cordelières, F. P., Dougherty, R. P., Jackson, 
J. S., Schmid, B., Hutchinson, J. R., and Shefelbine, S. J. (2010). BoneJ: free and extensible 
bone image analysis in ImageJ. Bone, 47(6), 1076–1079. 

Ercius, P., Alaidi, O., Rames, M. J., and Ren, G. (2015). Electron tomography: a three‐
dimensional analytic tool for hard and soft materials research. Advanced Materials, 27(38), 
5638–5663. 

Ercius, P., Weyland, M., Muller, D. A., and Gignac, L. M. (2006). Three-dimensional imaging of 
nanovoids in copper interconnects using incoherent bright field tomography. Applied 
Physics Letters, 88(24), 243116. 

Frank, J. (2008). Electron tomography: methods for three-dimensional visualization of structures 
in the cell. Springer. 

Garboczi, E. J., and Bentz, D. P. (1992). Computer simulation of the diffusivity of cement-based 
materials. Journal of Materials Science, 27(8), 2083–2092. 

Gilbert, P. (1972). Iterative methods for the three-dimensional reconstruction of an object from 
projections. Journal of Theoretical Biology, 36(1), 105–117. 

Gilbert, P. F., and Aaron, K. (1972). The reconstruction of three-dimensional structure from 
projections and its application to electron microscopy II. direct methods. Proceedings of 
the Royal Society of London. Series B. Biological Sciences, 182(1066), 89–102. 

Gordon, R., Bender, R., and Herman, G. T. (1970). Algebraic reconstruction techniques (ART) for 
three-dimensional electron microscopy and X-ray photography. Journal of Theoretical 
Biology, 29(3), 471–481. 

Groves, G. W. (1981). Microcrystalline calcium hydroxide in Portland cement pastes of low 
water/cement ratio. Cement and Concrete Research, 11(5–6), 713–718. 

Groves, G. W., Le Sueur, P. J., and Sinclair, W. (1986). Transmission Electron Microscopy and 
Microanalytical Studies of Ion‐Beam‐Thinned Sections of Tricalcium Silicate Paste. Journal 
of the American Ceramic Society, 69(4), 353–356. 

Herman, G. T., Lent, A., and Rowland, S. W. (1973). ART: mathematics and applications: a report 
on the mathematical foundations and on the applicability to real data of the algebraic 
reconstruction techniques. Journal of Theoretical Biology, 42(1), 1–32. 

Hewlett, P., and Liska, M. (2019). Lea’s chemistry of cement and concrete. Butterworth-
Heinemann. 

Holzer, L., Gasser, P., and Muench, B. (2006). Quantification of capillary pores and hadley grains 
in cement paste using FIB-nanotomography. In M. S. Konsta-Gdoutos (Ed.), Measuring, 
Monitoring and Modeling Concrete Properties (pp. 509–516). Springer Netherlands. 



82 
 

Huang, P. Y., Kurasch, S., Srivastava, A., Skakalova, V., Kotakoski, J., Krasheninnikov, A. V., 
Hovden, R., Mao, Q., Meyer, J. C., and Smet, J. (2012). Direct imaging of a two-dimensional 
silica glass on graphene. Nano Letters, 12(2), 1081–1086. 

Imbabi, M. S., Carrigan, C., and McKenna, S. (2012). Trends and developments in green cement 
and concrete technology. International Journal of Sustainable Built Environment, 1(2), 
194–216. 

Jiang, H., Song, C., Chen, C.-C., Xu, R., Raines, K. S., Fahimian, B. P., Lu, C.-H., Lee, T.-K., 
Nakashima, A., and Urano, J. (2010). Quantitative 3D imaging of whole, unstained cells by 
using X-ray diffraction microscopy. Proceedings of the National Academy of Sciences, 
107(25), 11234–11239. 

Königsberger, M., Hlobil, M., Delsaute, B., Staquet, S., Hellmich, C., and Pichler, B. (2018). 
Hydrate failure in ITZ governs concrete strength: a micro-to-macro validated engineering 
mechanics model. Cement and Concrete Research, 103, 77–94. 

Korpa, A., Kowald, T., and Trettin, R. (2009). Phase development in normal and ultra high 
performance cementitious systems by quantitative X-ray analysis and thermoanalytical 
methods. Cement and Concrete Research, 39(2), 69–76. 

Koster, A. J., Ziese, U., Verkleij, A. J., Janssen, A. H., and De Jong, K. P. (2000). Three-dimensional 
transmission electron microscopy: a novel imaging and characterization technique with 
nanometer scale resolution for materials science. The Journal of Physical Chemistry B, 
104(40), 9368–9370. 

Kremer, J. R., Mastronarde, D. N., and McIntosh, J. R. (1996). Computer visualization of three-
dimensional image data using IMOD. Journal of Structural Biology, 116(1), 71–76. 

Krivanek, O. L., Dellby, N., Nellist, P. D., Batson, P. E., and Lupini, A. R. (2001). Aberration-
corrected STEM: The present and the future. Microscopy and Microanalysis, 7(S2), 896–
897. 

Krivanek, O. L., Zhou, W., Chisholm, M. F., Dellby, N., Lovejoy, T. C., Ramasse, Q. M., Idrobo, J. 
C., Bell, D., and Erdman, N. (2013). Gentle STEM of single atoms: Low keV imaging and 
analysis at ultimate detection limits. Low Voltage Electron Microscopy: Principles and 
Applications, 119–161. 

Kübel, C., Voigt, A., Schoenmakers, R., Otten, M., Su, D., Lee, T.-C., Carlsson, A., and Bradley, J. 
(2005). Recent advances in electron tomography: TEM and HAADF-STEM tomography for 
materials science and semiconductor applications. Microscopy and Microanalysis, 11, 378–
400. 

LeBeau, J. M., Findlay, S. D., Allen, L. J., and Stemmer, S. (2008). Quantitative atomic resolution 
scanning transmission electron microscopy. Physical Review Letters, 100(20), 206101. 

Lee, E., Fahimian, B. P., Iancu, C. V, Suloway, C., Murphy, G. E., Wright, E. R., Castaño-Díez, D., 
Jensen, G. J., and Miao, J. (2008). Radiation dose reduction and image enhancement in 
biological imaging through equally-sloped tomography. Journal of Structural Biology, 



83 
 

164(2), 221–227. 

Levin, B. D. A., Jiang, Y., Padgett, E., Waldon, S., Quammen, C., Harris, C., Ayachit, U., Hanwell, 
M., Ercius, P., Muller, D. A., and Hovden, R. (2018). Tutorial on the visualization of 
volumetric data using tomviz. Microscopy Today, 26(1), 12–17. 

Li, J., Geng, G., Myers, R., Yu, Y.-S., Shapiro, D., Carraro, C., Maboudian, R., and Monteiro, P. J. 
M. (2019). The chemistry and structure of calcium (alumino) silicate hydrate: A study by 
XANES, ptychographic imaging, and wide- and small-angle scattering. Cement and Concrete 
Research, 115, 367–378. 

Liu, Y., Penczek, P. A., McEwen, B. F., and Frank, J. (1995). A marker-free alignment method for 
electron tomography. Ultramicroscopy, 58(3), 393–402. 

Marks, L. D. (1999). Experimental studies of small particle structures. Reports on Progress in 
Physics, 57, 603. 

McDonald, P. J., Rodin, V., and Valori, A. (2010). Characterisation of intra- and inter-C–S–H gel 
pore water in white cement based on an analysis of NMR signal amplitudes as a function of 
water content. Cement and Concrete Research, 40(12), 1656–1663. 

Mehta, P. K., and Monteiro, P. J. M. (2014). Concrete Microstructure, Properties, and Materials 
(5th ed.). McGraw-Hill Companies. 

Merlino, S., Bonaccorsi, E., and Armbruster, T. (2001). The real structure of tobermorite 11Å : 
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